
Platforma .NET
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Reakce na úkoly

R/W problém většinou v pořádku
▶ Občas nedostatečná synchronizace (čtenı́ při zápisu)

Rozmanitost v paralelizace
▶ Změna pár řádků a funguje paralelně
▶ Mı́sty ”masivnı́“ paralelizace

Opět korektně ošetřovat výjimky
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F# – Úvod

Autor: Dr. Don Syme z Microsoft Research (2005)

Functional-first programovacı́ jazyk

Ale podpora i ostatnı́ch paradigmat (OOP, imperativnı́)
▶ ale snaha se tomu vyhýbat (pokud to jde)

Od .NET Core je multiplatformnı́

Plnohodnotný .NET jazyk
▶ Překládán do CIL (vše co s tı́m souvisı́)

Silně typový

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 3 / 30



F# – Úvod

Využitı́ předevšı́m na analýzu dat
▶ Statistická analýza
▶ Machine learning
▶ Vizualizace dat

Interaktivnı́ skriptovánı́ – REPL

Může běžet i ve webovém prohlı́žeči (Fable – kompilován do JS)

Možné ale vytvářet i klasické aplikace, web, cloud
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F# – idea, vize

Snaha o stručnost, omezenı́ ”kódovacı́ho šumu“ (odvozovánı́ typů)

Pohodlı́ (zjednodušit psanı́), co největšı́ znovupoužitelnost

Čistota a správnost – typový systém, nemutovatelnost

Jednoduchá paralelizace

Interoperabilita s jinými jazyky (vs. čistota)
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F# – online zdroje

F# Software Foundation https://fsharp.org

Zkouška online: https://try.fsharp.org

F# in y minutes https://learnxinyminutes.com/docs/fsharp/

F# Programming WikiBook
https://en.wikibooks.org/wiki/F_Sharp_Programming

Oficiálnı́ dokumentace
https://learn.microsoft.com/en-us/dotnet/fsharp/
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F# – knihy

Isaac Abraham. Get Programming with F#. 2018. ISBN:9781617293993

Robert Pickering, Kit Eason. Beginning F# 4.0. 2016. ISBN:1484213742,
9781484213742

Antonio Cisternino, Adam Granicz, Don Syme. Expert F# 4.0. 2015. ISBN:
1484207424, 9781484207420

Mathias Brandewinder. Machine Learning Projects for .NET Developers. 2015. ISBN:
1430267666, 9781430267669

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 7 / 30



F# – zprovozněnı́

Přı́kazový řádek: dotnet fsi source.fs
▶ F# Interactive (REPL): dotnet fsi

VisualStudio – nativnı́ podpora, vytvořenı́ projektu
▶ F# Interactive: View→Other windows→F# Interactive (CTRL+ALT+F)
▶ Každý řádek/blok kódu jde vyhodnotit: pravý klik → Execute in Interactive

(ALT+Enter)

JetBrains Rider – také nativnı́ podpora
▶ Aktivace pluginu: Settings→Plugins→F# – activate
▶ F# Interactive: Tools→F# Interactive→Start new
▶ Každý řádek/blok kódu jde vyhodnotit: Tools→F# Interactive→Send to
Interactive (CTRL+\)

VisualStudio Code – VSCode, stiskněte Ctrl+Shift+P a zadejte přı́kaz:
ext install Ionide-fsharp
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F# – základy
Komentáře:

▶ Jednořádkový klasicky pomocı́ //
▶ Vı́ce řádků: začátek (* konec *)

// jednoradkovy komentar
(* viceradkovy
komentar *)

Rozlišenı́ kódu pro F# Interactive pomocı́ direktiv

#if INTERACTIVE
printfn "I’am using the F# interactive"
#else
printfn "I was called from the code"
#endif

Přı́kazy do F# Interactive musı́ končit dvěmi střednı́ky ;;
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F# – základy – hodnoty

Deklarace hodnot (”proměnných“)
▶ Nejsou mutovatelné, nefunguje přı́kaz přiřazenı́

let x = 5
let y = 6
let z = x + y
let a = 3.5
let text = "Jazyk F#"
let Cesko = "Ceska republika"
printfn "z: %i" z
printfn "a: %f" a
printfn "text: %s" text
printfn "stat: %s" Cesko
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F# – základy – funkce
Vytvořenı́ anonymnı́ funkce

fun x y -> x + y

Deklarace pojmenované funkce

let add = fun x y -> x + y

Zkrácěně

let add x y = x + y

Volánı́ funkcı́:

> add 20 22;;

Vı́ceřádkové funkce musı́me odsazovat

let myPrint a b c =
printfn "1. %s" a
printfn "2. %s" b
printfn "3. %s" c
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F# – lightweight syntax

F# je ve výchozı́m stavu white-space sensitive – použı́vá tzv. lightweight syntax

Ideou je toho psát co nejméně

Existuje i verbose syntax: https://learn.microsoft.com/en-us/dotnet/
fsharp/language-reference/verbose-syntax

Jde vypnout pomocı́ direktivy na začátku souboru

#light "off"
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Inference typů

Každá hodnota má typ, což zahrnuje i hodnoty, které jsou funkce

> let x = 1;;
val x : int = 1
> let s = "Ahoj";;
val s : string = "Ahoj"
> let add x y = x + y;;
val add : x:int -> y:int -> int

Je možné typ hodnoty definovat

let add (x: float) (y: float) = x + y;;
val add : x:float -> y:float -> float
> let f x = x;;
val f : x:’a -> ’a

Typy začı́najı́cı́ ’ jsou tzv. proměnné typy (generické typy)
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Větvenı́

If je výraz(expression) nikoliv přı́kaz(statement) – vracı́ hodnotu

if expr then
expr

elif expr then
expr

elif expr then
expr

else
expr

Operátory: =, <, <=, >, >=, <> (nenı́ rovno)
Logické operátory:&& (AND), || (OR), not (negace)

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 14 / 30



Funkce

V rámci funkcı́ je možné definovat dalšı́ funkce – vnořené funkce

let myFun a b =
let add x y = x + y
let sub x y = x - y
(add a (sub a b))

Rekurzivnı́ funkce musı́me označit klı́čovým slovem rec

let rec fib n =
if n = 0 then 0
elif n = 1 then 1
else fib (n - 1) + fib (n - 2)
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Pattern matching
Modernı́ přı́stup jak transformovat vstupnı́ data

Pattern(vzor) – ”dotaz“ na strukturu, tvar, přesné hodnoty v datech

Usnadnı́ výrazy v podmı́nkách

match expr with
| pat1 -> result1
| pat2 -> result2
| pat3 when expr2 -> result3
| _ -> defaultResult

Přı́klad:

let rec fib n =
match n with
| 0 -> 0
| 1 -> 1
| _ -> fib (n - 1) + fib (n - 2)
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Pattern matching (alternativnı́ syntax)

let getPrice = function
| "banana" -> 0.79
| "watermelon" -> 3.49
| "tofu" -> 1.09
| _ -> nan // Not a Number

> getPrice "tofu";;
val it : float = 1.09

let rec fac = function
| 0 | 1 -> 1
| n -> n * fac (n - 1)

Pattern matching se vyhodnocuje shora dolů
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Funkce vyššı́ch řádů
F# samozřejmě podporuje funkce vyššı́ch řádů:

let square x = x * x
let cube x = x * x * x
let passFive f = f 5
printfn "%i" (passFive square)
printfn "%i" (passFive cube)

Také currying

let add x y = x + y
let addFive = add 5
> addFive 12;;
val it : int = 17

let add x y = x + y je totiž formálně jen zkratka za:

let add = (fun x -> (fun y -> x + y))
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N-tice (tuples)

Seskupenı́ nepojmenovaných, ale seřazených hodnot
Mohou mı́t odlišné typy
Jak referenčnı́(výchozı́), tak hodntové
Časté využité v pattern matchingu, přiřazenı́ vı́ce proměnným, vı́ce návratových
hodnot

let a = (1, 2)
let b = (1, 3, 5)
let c = (1, "text")

let avg (a, b, c) = (a + b + c) / 3
let getPowTuple a = (a, a*a)

let d = struct (1, 2)

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 19 / 30



N-tice – použitı́
Pattern matching

let greeting (name, language) =
match (name, language) with
| ("Steve", _) -> "Howdy, Steve"
| (name, "English") -> "Hello, " + name
| (name, _) when language.StartsWith("Span") -> "Hola, " + name
| (_, "French") -> "Bonjour!"
| _ -> "DOES NOT COMPUTE"

Přiřazenı́ vı́ce hodnotám

let val1, val2, ... valN = (expr1, expr2, ... exprN)
let x, y = (1,2)

Návratová hodnota

> let pows x = (x*x, x*x*x, x*x*x*x);;
val pows: x: int -> int * int * int
> pows 5;;
val it: int * int * int = (25, 125, 625)
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Záznamy (records)
Sdruženı́ pojmenovaných hodnot
Referenčnı́(výchozı́) i hodnotové
Definice:

type recordName = { [ fieldName : dataType ] ... }

Přı́klad:

type website = { Title : string; Url : string }
let homepage = { Title = "Google"; Url = "http://www.google.com" }

Ve výchozı́m stavu nemutovatelné

type coords = { X : float; Y : float }
let setX item newX = { item with X = newX }
let start = { X = 1.0; Y = 2.0 }
let finish = setX start 15.5

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 21 / 30



Záznamy (records)

Nad záznamy lze také provádět Pattern matching

type coords = { X : float; Y : float }
let getQuadrant = function

| { X = 0.0; Y = 0.0 } -> "Origin"
| item when item.X >= 0.0 && item.Y >= 0.0 -> "I"
| item when item.X <= 0.0 && item.Y >= 0.0 -> "II"
| item when item.X <= 0.0 && item.Y <= 0.0 -> "III"
| item when item.X >= 0.0 && item.Y <= 0.0 -> "IV"
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Discriminated union

Datový typ, který může nabývat právě jedné hodnoty z pevně daných
Jednotlivé přı́pady mohou být různých datových typů
Mohou být rekurzivnı́ – vhodné pro rekurzivnı́ datové struktury (stromy, seznamy)

type unionName =
| Case1
| Case2 of datatype
| ...

type switchstate =
| On
| Off

> let x = On;;
val x : switchstate = On
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Discriminated union – strom

Definice a vytvořenı́ stromu

type tree =
| Leaf of int
| Node of int * tree * tree

let myTree1 = Node(1,Leaf(2),Leaf(3))
let myTree2 = Node(1,

Node(2,Leaf(3),Leaf(4)),
Leaf(5))

I discriminated union můžeme použı́vat v Pattern matchingu

let rec printTree = function
| Leaf value -> printf "Hodnota v listu %i;" value
| Node (value, left, right) -> printf "Hodnota v uzlu %i;" value;

printTree left; printTree right;
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Discriminated union – option type

Předdefinovaný datový typ, který může nabývat pouze dvou hodnot
▶ Some – má hodnotu
▶ None – nemá hodnotu

Definice ve standardnı́ knihovně:

type Option<’a> =
| Some of ’a
| None

Přı́klad použitı́:

let safediv x y =
match y with
| 0 -> None
| _ -> Some(x/y)
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Seznamy
Uspořádaná sekvence hodnot stejného datového typu
Nemutovatelné
Prázdný seznam: []

let list1 = [1; 2; 3; 4; 5; 6; 7; 8; 9; 10]

Vytvořenı́ pomocı́ cons operátoru ::

let list2 = 1::2::3::[]

Dalšı́ možnosti vytvořenı́

let list3 = List.init 5 (fun index -> index * 3) // pouziti List.init
let list4 = [1 .. 10] // list comprehensions
let list5 = [’a’ .. ’f’] // list comprehensions
let dalsi = 100::list1
let spojene = list1 @ dalsi

Možný přı́stup přes index (pamatovat na neefektivitu)

> list1[3];;
val it: int = 4
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Seznamy – Pattern matching

Seznam můžeme do Pattern matchingu rozložit pomocı́ cons ::

let sum l =
let rec sumStep counter = function

| [] -> counter
| h::t when t = [] -> sumStep (counter + 5 * h) t
| h::t -> sumStep (counter + h) t

sumStep 0 l

Velké množstvı́ funkcı́ v modulu List
▶ List.rev
▶ List.filter
▶ List.map
▶ List.append nebo infixový operátor @
▶ List.choose – filter a map zároveň
▶ List.fold a List.foldBack
▶ List.find a List.tryFind – find při nenalezenı́ prvku vyvolá vyjı́mku
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Seznamy

Na co se vyhodnotı́:

List.rev (List.map (fun x -> x * x) (List.filter (fun x -> x % 2 = 1)
(List.init 8 (fun index -> index * 3))))

val it: int list = [441; 225; 81; 9]

Syntaxe se stává nepřehlednou ⇒ zaveden Pipe-forward operátor |>

let (|>) x f = f x

Vede na značné zpřehledněnı́

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 23. 10. 2025 28 / 30



Seznamy

Předchozı́ kód tak může vypadat takto:

List.init 8 (fun index -> index * 3)
|> List.filter (fun x -> x % 2 = 1)
|> List.map (fun x -> x * x)
|> List.rev

val it: int list = [441; 225; 81; 9]
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Úkol

Naprogramujte následujı́cı́ funkce (souvisı́ spolu):
1 gcd, která bude počı́tat největšı́ho společného dělitele.
2 addFrac, subFrac, mulFrac, divFrac pro sčı́tánı́, odčı́tánı́, násobenı́ a dělenı́

zlomků (funkce budou vracet zlomky v základnı́m tvaru)
3 comb, která spočı́tá kombinačnı́ čı́slo

Pro jednoduchost stačı́, že budou všechny funkce počı́tat pouze s celými čı́sly
▶ Zkuste vhodně navrhnout a zvolit datové typy

Dále naprogramujte funkce
1 sumOfTree, která spočı́tá součet hodnot ve výše definovaném stromu
2 leavesToList, která vrátı́ všechny hodnoty z listů v jednom seznamu
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